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Checklist 

This checklist contains questions about the Macintosh interface that you can 
ask yourself while reviewing software. These questions will help bring to 
mind the particulars of the guidelines. 

The questions here cover all the guidelines except those for selection. The 
selection standards of the guidelines are detailed, so refer to "Selecting" on 
page 286 in Chapter 10, "Behaviors," for information about them. 

You must be able to answer every question "yes" to ensure conformity with 
the guidelines. However, sometimes it is necessary to make tradeoffs in your 
application in order to provide the most usable interface. Remember to 
maintain the spirit of the guidelines and the principles when reviewing 
your product. 

General Considerations 

• Does the application have the "look" of the Macintosh desktop interface 
(including, but not limited to, desktop, windows, and menus)? 

• Does the application have the "feel" of the Macintosh desktop interface 
(including, but not limited to, pointing, selecting, and keyboard input)? 

• If a metaphor is being used, is it suitable for the application? Does the 
metaphor match a "real" visual and behavioral representation, as with the 
desktop, so that the users do not have to carry a "map" in their head? 

• Does the application always provide some indication that an activity is 
being carried out in response to a command? 

• Is suitable feedback provided during task processing? Is the completion of 
a processing task indicated somehow? Is the duration of the task indicated? 

• Does the user always have the option of finding an object or action on the 
screen? In other words, does your interface follow the see-and-point 
principle of design? 

• Are the operations consistent with the standard elements of the interface; 
that is, if a user is familiar with such applications as MacPaint, MacDraw, 
and MacWrite, will the application seem like familiar territory? 

• Is a printout a replica of what the user sees on the screen? In other words, 
is it WYSIWYG (what you see is what you get)? 

• Is an explanation offered if a particular action cannot be carried out? 
Are alternatives offered? 
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• Are there warnings about risky actions? Are there different warnings for 
different levels of risky actions? Are there enough warnings without being 
too many? Are users allowed to back away gracefully from risky territory? 

• Is there a feeling of stability? 

• If an operation can be interrupted, do you provide a Cancel or Stop button? 
Can Escape or Command-period be used to cancel or stop these operations? 

• Is your application forgiving and explorable by supporting Undo? 

• Do you avoid assigning new behaviors to existing objects? 

• Do you make all changes clearly visible? 

• Do you interpret user's responses consistently? 

• Do you use progressive disclosure, as appropriate? 

• When your application runs in the background, do you gently call the 
user's attention to a task completion or request for input by using the 
Notification Manager? If an immediate response is crucial and the user 
doesn't respond to a notification request, does your application handle the 
situation gracefully? A background application should not take control 
from the user by placing an alert box on the screen when the user hasn't 
activated the application. 

• Is your application MultiFinder friendly? Better workflow is possible when 
the user can easily switch back and forth between applications. 

• If there are modes, is there a clear visual indication of the current mode? 
Does the visual indication of the mode appear near the object most affected 
by the mode? Are there enough landmarks to remind the user what area of 
the application he or she is in? For example, the MacPaint pointer changes 
to a pencil in draw mode and to a paint brush in paint mode. 

• Is each mode absolutely necessary? Do the modes within the application 
properly track the user's own modes? Do users consistently avoid the kind 
of errors caused by the program being in a mode other than what the user 
wants or expects? Making a mode visually apparent is no guarantee that 
the user will track it: test the application on users and find out what sorts 
of mistakes they are making. If the errors are caused by modes, eliminate 
the modes. 

• Can the user save a document or quit an application at any time, unless he 
or she is in a modal dialog box? 

• Are the widest possible range of user activities available at any time? 
The user should spend most of his or her time in the event loop. 

• Will a user unable to distinguish colors be able to use the application? Will 
someone without a color monitor be able to use it? The information 
conveyed by color coding should also be presented in another form, 
such as text, position, highlighting, gray-scale variations, or pattern. 
(These questions do not apply to programs in which the task to be carried 
out requires full-color vision on a color monitor.) 
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• Will a user with a hearing disability be able to use the application? Audible 
messages should be supplemented with visual cues or should allow the 
user to choose visible instead of audible messages. (This question may not 
apply to music programs.) 

Graphic Design 

Color 

• Did you use graphics to illustrate commands, features, and parameters of 
the applications, as well as all of the user's data, whenever possible? 

• Do the graphics resemble items that users are familiar with? Did you leave 
out insignificant detail (which unnecessarily complicates a graphic)? 

• Does the screen look "clean" and free from clutter? 

• Does the user have control over the design of the workplace, allowing him 
or her to individualize it? 

• Is the information in windows organized so that the most important 
information can be read first? 

• Does your design look good at different bit depths on all Macintosh 
computers? 

• Do you use a consistent light source, one that always comes from the 
upper-left corner of the screen? 

• Do you use white space and graphics to break up long pieces of text? 

• Do you always design for black and white first and then colorize 
your design? 

• Are your black-and-white designs two-dimensional? 

• Do you avoid using color as the only means of communicating important 
information? 

• Are the colors carefully chosen? Are bright colors used sparingly and only 
in small areas? Do you use light or subtle colors for large areas? 

• Do you maintain a close visual relationship between a black-and-white 
design and its colorized version? 

• Do you use true gray instead of a 50 percent gray pattern when a color 
monitor is present? 

• Do you use the Color Picker where appropriate? 

• Do any custom elements, such as tool palettes or special window controls, 
follow the color scheme of the operating system? Do the colors get updated 
when the user changes the color in the Color control panel? 
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• Do your icons represent objects that users are familiar with? 

• Do your icons fit in with the desktop metaphor? 

• Do you provide complete icon families, with 'ICN# ', 'ics# ', 'icl4 ', 
'ics4 ', 'icl8 ',and 'ics8' icons? 

• Are icon colors chosen from the palette of 34 colors? 

• If your application supports stationery pads, the Edition Manager, or the 
Data Access Manager, do you provide icons that distinguish the stationery 
pads, editions, or query documents for your application? 

• Do the standard window size and position take into account the 
dimensions of the screen? 

• Is the standard state of a window best suited to working on the document 
(such as no wider than the page width), and not necessarily as large as the 
full screen? 

• Does your application make sense when it chooses to open a window in 
either the standard or the user-selected state? 

• Can each sizable window be made as large as the smaller of either the 
maximum document size or the maximum size of the displays, including 
multiple monitor displays? 

• Is the default position of a window contained on a single screen? 

• Is each additional window opened below and to the right of its 
predecessor? 

• If a user drags a window from one monitor to another monitor, does your 
application open subsequent windows on the second monitor? 

• Do you use the lowercase letters "untitled" in a new window title? Do 
you avoid using additional punctuation in window titles? Do you avoid 
using blank titles? Do you avoid adding a number to the title of the first 
new window? 

• Before closing a window, do you check to see if the user has changed its 
size or position? Do you save window positions, and then reopen windows 
in the size and position in which the user left them? 

• Before reopening a window, do you make sure that the size and position 
are reasonable for the user's current monitor or monitors, which may not 
be the same as the monitor on which the document was last open? 
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• When zooming from the user state to the standard state, do you check if 
the size of the standard state would fit completely on the screen without 
moving the upper-left corner? If so, is the upper-left corner anchored? If 
not, is the window moved to an appropriate default location? 

• When a window becomes inactive, do the close box, zoom box, size box, 
stripes in the title bar, and scroll bars disappear? 

• Do you avoid displaying the selection in an inactive window? (You can use 
a secondary selection technique such as an outline to indicate where the 
selection is in an inactive window.) 

• Are questions in dialog boxes posed in a straightforward and positive 
way-for example, "Do you want to erase everything on the disk named 
"James Bond?" rather than "Do you not want to alter the contents of 
this disk?" 

• Do dialog boxes and alert boxes appear on the screen where the user's 
focus of attention is, not necessarily where the menu bar is? 

• Are dialog boxes horizontally centered either on the screen or over the 
active window if the window is on a large screen or on a screen other than 
the one the menu bar appears on? 

• If a movable modal dialog box is displayed, can the application run in the 
background? 

• Do you provide access to the menu bar when you display a movable modal 
dialog box? Are the Help, Edit, Keyboard, and Application menus enabled 
as appropriate? 

• Are movable modal dialog boxes truly modal within the application? 

• Do movable modal dialog boxes have a drag region (title bar)? Do movable 
modal dialog boxes not have a close box? For black-and-white monitors, do 
movable modal dialog boxes have a two-pixel-wide outline within the 
content region to signify that it is a modal dialog box? 

• Can the Help menu be used when a modal dialog box is displayed? 

• If there is an active editable text box in a modal dialog box, can the Cut, 
Copy, Paste, and Undo menu commands in the Edit menu be used? 

• Do keyboard equivalents of the standard Edit menu commands operate 
correctly in a modal dialog box containing editable text items? 

• When a scrolling list is present in a dialog box, can type selection be used? 
Can the arrow keys be used to move the selection by one item in the 
direction of the arrow? 

• Does the active area of a dialog box have an indicator if there is more than 
one possible active area? (Active areas are those that accept typing such as 
scrolling lists with type selection or text boxes.) 
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• Does clicking a desired element move the active area to that element? 

• Does pressing the Tab key cycle through the available elements? Does 
Shift-Tab cycle in the reverse direction? 

• When appropriate, are buttons named with a verb that describes the action 
that it performs, such as Erase rather than OK? 

• Do you provide a Cancel button wherever possible, especially in progress 
dialog boxes? Does pressing Escape or Command-period indicate Cancel in 
a dialog box or alert box? (Pressing Escape should never cause the user to 
lose information.) 

• If an operation can be halted midstream, with possible side effects, is the 
button named Stop instead of Cancel? 

• Do the Return and Enter keys map to the default button, which is usually 
the button with the safest result or the most likely response? 

• Are default buttons outlined with an additional border of three black 
pixels, separated by a border of one white pixel? 

• Do you avoid displaying a default border around any button when you use 
the Return key in editable text boxes? 

• When a button is activated by keyboard equivalents, is the button 
highlighted for eight ticks of the clock to give visual feedback that the item 
has been chosen? 

• Are buttons 20 pixels high? Are they wide enough for their text names 
(with a minimum of 8 pixels on each side of the text)? 

• Are buttons placed in functional and consistent locations, both within your 
application and across all applications that you develop? Is the action 
button placed in the lower-right comer with the Cancel button to its left or 
above (for Western readers)? 

• Do you use a consistent amount of white space between the border of the 
dialog box and its elements, thus creating a balanced appearance in 
the dialog box? 

• When a dialog box or alert box refers to a document or an application, do 
you use the name of the document or application in the text? 

• Do you use curly quotation marks (single and double) instead of straight 
quotation marks? (This also applies to apostrophes.) 

• When you must unavoidably nest dialog boxes, do you dim the 
background dialog box and buttons, so that the frontmost dialog box 
stands out? 

• Do your modeless dialog boxes have a close box? Such dialog boxes should 
not have buttons that dismiss the dialog box. 

• Has room been left to allow the dialog box to grow during localization? 
Most languages require more characters than English to convey 
equivalent messages. 
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• Are display rectangles of dialog box items (for example, radio buttons and 
checkboxes) the same size? When the alignment of dialog box items is 
reversed, the items should align on the opposite side. 

• Do alert boxes have the proper level of severity and show the proper icon 
associated with each severity level? 

• Are alert boxes vertically positioned so that one-fifth of the remaining 
desktop area is above the alert box? 

• Do the alert icon and message fit the situation? 

• Does your application use the system alert sound (SYSBEEP) so that the 
user's menu bar automatically flashes (inverts rapidly) if the sound is 
turned off when they receive an alert message? 

• Does the alert message not only tell the user what is wrong, but also offer 
suggestions as to what to do to correct it? The best alert messages answer 
the following questions: What happened? Why did it happen? What can I 
do about it? 

• Is this alert box necessary? Often, the user can be prevented from making 
an error. For example, if the application cannot handle an SO-character 
filename, don't display an SO-character field in which to enter it. 

• Does the window use either the standard scroll bar mechanism or the hand 
for scrolling? If it uses the hand, does the pointer either always become a 
hand in the window or appear highlighted in a tool palette? 

• Does clicking a scroll arrow cause the document to move a distance of one 
unit in the chosen direction? (The unit should be appropriate and 
meaningful for the application.) 

• Does clicking in the scroll bar below the scroll box advance the document 
by a windowful? (A windowful is the height or width of a window, minus 

<,,,; a one-unit overlap.) Does clicking above the scroll box move the document 
back by a windowful? 

• If the user drags the scroll box and then moves the pointer well outside the 
scroll bar, does the scroll box snap back to its original position? 

• Is the function of the arrow keys different from the function of the scroll 
bar? (Arrow keys should not substitute for scroll arrows.) 

• Are the scroll bars inactive when the document is no larger than 
the window? 
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• Are the scrolling keys on the keyboard (Page Up, Page Down, Home, End) 
supported? Note that these keys do not move the insertion point and do 
not affect the selection. 

• Does the scroll box indicate the approximate position of the visible part of 
the document in comparison to the whole document? 

• Are the Apple, File, and Edit menus present, with at least the standard 
items? (These menus are needed for desk accessories, even when the 
application doesn't use them.) 

• Has enough room been left on the right side. of the menu bar for the menu 
that some desk accessories add to the menu bar? Is there also enough extra 
room to allow for the expansion that almost always occurs during 
translation into other languages? 

• Do the unique menus of the application have names that are appropriate? 
Are the names sufficiently different from the standard menu names? Can 
the user understand and remember their meaning? 

• Are frequently used menu items available at the top level rather than in a 
submenu or a dialog box? If not, can the user move them up? 

• When an item in a menu is currently disabled, is it dimmed in the menu 
rather than missing from it? 

• If all the items in a menu are currently disabled, is the menu title dimmed? 
Can the user still pull down the menu and see the dimmed names of 
the operations? 

• Are toggled menu items either unambiguously a verb or unambiguously a 
state of being? 

• Are menu titles and items in caps/lowercase unless there is a compelling 
reason to have a different style, such as ALL CAPS in a Style menu? 

• Do menu items have an ellipsis character (. .. ) if more information is 
required from the user before completing the command? 

• Do menu items blink briefly, and is the menu title highlighted until the 
command is complete? 

41"'J 

• Are the dotted lines in menus (as well as dimmed items) unselectable? 
These items should not be highlighted when the user moves the mouse 
pointer over them. 

• Are the menu items truly menu items? Menu items should not be used as 
text, section titles, or status indicators. 

• In a hierarchical menu, does the title of the submenu have a right-pointing 
triangle? Are submenus used only for lists of related items? 
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• Can the user see all the commands, items, and submenu titles in a menu 
without scrolling? Scrolling should be necessary only for menus that users 
have added to or for menus that spill over because the user has selected a 
large system font. 

• Does the application support Undo, Cut, Copy, and Paste? 

• If the application is text oriented, can the user change the font and style by 
using menu commands? 

• Do pop-up menus have a downward-pointing triangle and a one-pixel 
drop shadow? While the menu is showing, is its title inverted and is the 
current value checked? If the menu must be scrolled, is this indicated by a 
triangle pointing up or down? 

• Are pop-up menus used to allow the user to choose only one of a set 
of several choices? Pop-up menus should not be used for choosing 
more than one item from a set of several choices. 

• Do you avoid adding menu items that contain verbs (actions) in 
pop-up menus? 

• Is the same font used for the normal state and the open state of a 
pop-up menu? 

• Do you avoid making the pop-up menu narrower in the open state 
than in the closed state? 

Palettes and Tear-Off Menus 

• If a tool palette is present, is the selected symbol (icon, pattern, character, or 
drawing) highlighted? 

• Do palettes provide tracking feedback when the mouse button is down? 

• Does any change in selection in palettes occur only when the mouse button 
is released? 

• If a menu has been torn off and moved, can the user still get access to it 
from the menu bar? When it is torn off a second time, does the first 
instance disappear? 

• Do tear-off menus have a drag region with a 25 percent black-and-white 
pattern and a close box? 

• Do tear-off menus always appear on top of open document windows? 
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Mouse Standards 

Text 

Balloon Help 

360 

• If the user initiates an action by pressing the mouse button, does the action 
take place only when the button is released? 

• Are there ways other than double-clicking to perform a given action? 
Double-clicking should never be the only way to do something; it should 
only be a shortcut. 

• Can arrow keys be used in all text boxes (including dialog boxes)? Can the 
Shift key be used with the arrow keys to extend the selection (including in 
dialog boxes)? 

• If text is selected, does pressing an arrow key cause the insertion point 
to go to the corresponding end of the range and deselect it? 

• Are discontinuous selections made with the Command key modifier 
(for text and arrays)? The Shift key is used for graphics selections. 

• Do you support intelligent cut-and-paste where appropriate? 

• Do you use Command-arrow and Option-arrow for moving the insertion 
point in larger semantic units? (Note that when multiple script systems are 
available, Command-Left Arrow and Command-Right Arrow are 
intercepted by the Script Manager and used for changing the script system.) 

• If your application supports TrueType fonts, do you support all font sizes 
instead of imposing a size limit? 

• Do the users have a way to choose whatever font size they desire? 

• Does the active font size in a menu have a checkmark next to it? 

• Are available font sizes shown in outline in the menu items? 

• Do you avoid making assumptions about font sizes? For example, 
the system font may have a different size in other countries. 

• Do you provide Balloon Help for items in dialog boxes, alert boxes, 
and menus? 

• Do you provide Balloon Help for application window contents? 

Mouse Standards 
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Checklist 

• Do you provide a custom help balloon for your application icon, 
if appropriate? 

• Do your help balloons answer at least one of these questions: 

o What is this? 

o What does this do? 

o What happens if I click this? 

• Is the content of the help balloons short and easy to understand? 

• Do you use clear, concise phrases and active constructions? 

• Do you use terminology consistently? 

• When a balloon appears, is it positioned so that it does not obstruct any 
interface elements being referred to by the balloon? 

• Do you provide different balloon messages for different states of an item 
(such as enabled, disabled, and checked)? 

• Do you add a menu item for help-related information to the Help menu? 
Does this menu item use the name of your application? 

Keyboard Equivalents 

• Are Apple-reserved keyboard equivalents used properly? Even if your 
application doesn't support one of these menu commands, it shouldn't use 
these keyboard equivalents for another function. 

• Do you avoid using Command-Space bar and Command-modifier 
key-Space bar in your application, since they are reserved for use by the 
Script Manager? 

• Do keyboard equivalents appear where appropriate? Are the keyboard 
equivalents case-independent? (This second rule does not apply if the 
product uses both cases in the keyboard equivalents and enables the user 
to predict which case to use.) 

Edition Manager 

• If your application implements the capabilities of the Edition Manager, do 
you provide the following commands in the Edit menu, separated from the 
standard commands by a gray line? 

o Create Publisher ... 

o Subscribe To ... 

o Publisher /Subscriber Options ... (context-sensitive toggle command) 

o Show /Hide Borders (optional context-sensitive toggle command) 

o Stop All Editions (optional command) 

Keyboard Equivalents 361 
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Checklist 

• Do publishers have borders that are three pixels wide with 50 percent gray 
lines, when appropriate? 

• Do subscribers have borders that are three pixels wide with 75 percent 
gray lines? 

• Are the contents of the section separated from the border itself by one pixel 
of white space? 

• Does the manual include a glossary of potentially confusing terms that 
relate to the application or to the application's topic? 

• If the manual refers the user to another document, is the reference more 
appropriate than having the information in the manual itself? 

• For those who cannot handle book-form manuals, is any part of the 
manual available in electronic form? 

• Is the manual written for its audience? 

Documentation 
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accumulating attribute group A group of 
attributes of which any number of attributes can 
be in effect at the same time. For example, the 
Style menu allows users to apply a number of 
different style attributes, such as italics, bold, and 
underline, to a single piece of text. (In dialog 
boxes, accumulating attributes are represented by 
checkboxes.) Compare mutually exclusive 
attribute group. 

activate To make an inactive window active by 
clicking anywhere inside it. 

active application The application with which 
the user is currently interacting. Its icon appears 
on the right end of the menu bar. 

active end The point at which the user releases 
the mouse button when selecting a range of 
objects (text, arrays, and graphics) by dragging 
through them. Compare anchor point. 

active window The frontmost window on the 
desktop; the window where the next action will 
take place. The active window is the window on 
the screen that has horizontal lines in its title bar. 

addition method A method for extending a 
continuous selection of text, using Shift-click, 
which adds new text to a current selection. 
Compare fixed-point method. 

additive color A model of color based 
on adding the basic hues together to make 
additional colors. 

alert A warning or report of an error in the 
form of an alert box, a sound from the 
computer's speaker called an alert sound, or both. 

alert box A window that appears on the screen 
to warn the user or to report an error. An alert 
box may or may not be accompanied by an 
alert sound. 

alert sound An audible warning from the 
computer speaker that warns the user of an 
unusual or potentially undesirable situation. 
An alert sound may or may not be accompanied 
by an alert box. 

anchor point The point at which the user 
presses the mouse button to begin selecting a 
range of objects by dragging through them. The 
anchor point is at one comer of the range of 
objects. Compare active end. 

Apple menu The menu farthest to the left in 
the menu bar, indicated by an Apple symbol, 
which contains items the user puts in the 
Apple Menu Items folder. 

application A program that performs a specific 
task, such as word processing, database 
management, or graphics. An application's 
file type is 'APPL'. 

Application menu The menu farthest to the 
right in the menu bar, which displays a list of the 
applications that are currently running on a 
user's computer. Allows users to change 
applications by choosing an item, typically the 
name of an application, in this menu. 

array An arrangement of fields containing 
information (text or graphics) through which a 
user navigates using the Tab key. 

arrow keys The four directional keys in the 
lower-right comer of the keyboard. The user can 
use the arrow keys to move around in an 
application. 

auto-key event An event generated repeatedly 
when the user presses and holds dowtt a 
character key on the keyboard or keypad. 

auto-repeat See auto-key event. 
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Balloon Help An onscreen help system 
consisting of balloons that describe items on the 
screen. A help balloon appears when the user 
moves the pointer to an item and disappears 
when the user moves the pointer away from 
the item. 

bitmap A set of bits that represents the 
positions and states of a corresponding set of 
items, such as pixels. 

bitmap-based graphics application A graphics 
application that creates images by turning on 
individual pixels on the screen. Each graphic is a 
collection of pixels. 

brightness A measurement of the amount of 
black in a color-the less black, the brighter the 
color. Brightness is equivalent to lightness in the 
HLS color system, and it is equivalent to value in 
the HSV color system. 

button An image, often resembling a push 
button, in dialog boxes that the user clicks to 
designate, confirm, or cancel an action. Compare 
mouse button, radio button. 

Cancel button A button that appears in many 
dialog boxes. Clicking it closes the dialog box 
and returns the computer to the state it was in 
before the dialog box appeared. 

caret A generic term for a symbol that indicates 
where the next text will be inserted. The caret 
used in Macintosh text is a vertical bar (I). 

cell The intersection of a row and a column in a 
spreadsheet. A cell can hold a number, label, 
function, or formula. 

character Any symbol that has a widely 
understood meaning and thus can convey 
information. Some characters-such as letters, 
numbers, and punctuation-can be displayed on 
the monitor screen and printed on a printer. 

character code An integer representing 
the character that a key or key combination 
stands for. 

character key A key on a keyboard that 
sends characters to the computer. Compare 
modifier key. 
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checkbox A standard Macintosh control that 
displays a setting, either checked (on) or 
unchecked (off). Clicking a checkbox or its text 
label reverses its setting. One or more checkboxes 
can be checked. Compare radio button. 

Clear A command in the Edit menu that 
removes selected material without placing it on 
the Clipboard. The user can restore the material 
with the Undo command. 

Clear key A key on the numeric keypad that 
has the same effect as choosing the Clear 
command from the Edit menu. 

click (v.) To position the pointer on something, 
and then press and quickly release the mouse 
button. (n.) The act of clicking. 

Clipboard The holding place for what the 
user last cut or copied; a buffer area in memory. 
Information on the Clipboard can be pasted 
into documents. 

close To turn a window back into the icon that 
represents it by choosing the Close command or 
by clicking the close box on the left end of the 
window's title bar. 

close box The square box on the left end of the 
title bar of an active window. Clicking it closes 
the window. 

Close View A control panel, included with 
system software, for people with a visual 
disability. It enlarges everything on the screen 
up to sixteen times the standard size and allows 
users who have difficulty seeing black on 
white to invert screen images to white on a 
black background. 

collaborative computing A shared computing 
environment or an application that facilitates 
communications and teamwork among a group 
of people. 

command An instruction that causes a device 
such as a computer or printer to perform some 
action. A command can be selected from a menu 
with a hand-held device (such as a mouse), typed 
from a keyboard, or embedded in a program. 
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Command key A key that, when held down 
while another key is pressed, causes a command 
to take effect. The Command key is marked with 
a propeller-shaped symbol. On some keyboards, 
the Command key has both the propeller symbol 
and the Apple symbol on it. 

context sensitive Able to perceive the situation 
in which an event occurs. For example, if an 
application program presents help information 
specific to the particular task the user is 
performing, rather than a general list 
of commands, that help is said to be 
context sensitive. 

control An object in a window on the 
Macintosh screen with which the user, by using 
the mouse, can cause instant action with visible 
results or change settings to modify a future 
action. The control is internally represented in a 
control record. 

control panel A utility that lets the user change 
global features such as the speaker volume, the 
keyboard repeat speed and delay, mouse 
tracking, and number of colors displayed. 

cursor See pointer. 

database (1) A collection of information 
organized in a form that can be readily 
manipulated and sorted by a computer user. 
(2) Short for database management system. 

default A value, action, or setting that a 
computer system assumes unless the user gives 
an explicit instruction to the contrary. 

default button In an alert box or a modal 
dialog box, the button whose effect occurs if the 
user presses Return or Enter. In an alert box, it's 
boldly outlined; in a modal dialog box, it's boldly 
outlined or it's the OK button. 

delete To remove something, such as a 
character or word from a file, or a file from a 
disk. Keys such as the Delete key and the 
Backspace key can remove one character at a 
time by moving to the left (in languages that read 
from left to right). The Cut command removes 
selected text and places it on the Clipboard; the 
Clear command removes selected text without 
placing it on the Clipboard. (The Undo command 
can reverse the action of Clear and of the Delete 
or Backspace key if it is used immediately.) 

Delete key A key that moves the insertion 
point backward, removing the previously typed 
character, or that removes the current selection. 
Its function is identical to that of the Backspace 
key on the original Macintosh keyboards. 
Compare Forward Delete key. 

desk accessory A small application that 
provides a specific, limited capability for a 
particular task, for example, the Calculator, the 
Note Pad, and Key Caps. In versions of system 
software earlier than System 7, desk accessories 
were always in the Apple menu. In System 7, a 
desk accessory can be in the Apple menu or 
anywhere in the file system. From the user's 
point of view, there is little distinction between 
desk accessories and applications. 

desktop The working environment on the 
computer-the background on which icons and 
windows are displayed (minus the menu bar). 

dial See slider. 

dialog box A box that appears on the screen 
to solicit information from the user or to report 
that the computer is waiting for a process to 
complete. For example, a typical printing dialog 
box requests the user to specify such options as 
number of copies of a document to print. A 
dialog box is internally represented in a dialog 
record. See also modal dialog box, modeless 
dialog box, and movable modal dialog box. 

dimmed Used to describe words or icons that 
appear in gray. For example, menu commands 
appear dimmed when they are unavailable; 
folder icons are dimmed when they are open. 

dimmed icon An icon that represents an 
opened disk or folder or a disk that has 
been ejected. 

disabled Describes a menu item or an item in a 
dialog box or alert box that cannot be chosen; the 
item appears dimmed. 

discontinuous selection A selection that 
consists of objects that are not adjacent to 
one another. 

document A file the user creates and can open, 
edit, and print. See also file. 
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document window The window that displays 
the content of a document. 

double click (n.) Two clicks in quick 
succession, interpreted as a single command. 
The action of a double click is different from that 
of a single click. For example, clicking an icon 
selects the icon; double-clicking an icon opens it. 

double click (v.) To press and release the mouse 
button twice in quick succession without moving 
the mouse. 

drag To position the pointer on something, for 
example, a window icon, press and hold the 
mouse button, move the mouse, and release the 
mouse button. 

drag region A region in a window frame; 
usually the title bar. Dragging inside this region 
moves the window to a new location and makes 
it the active window. (The window doesn't 
become active if the Command key is down 
while the window is dragged.) 

Easy Access A feature of system software that 
assists people who have difficulty typing on the 
keyboard or manipulating the mouse. See also 
Mouse Keys, Slow Keys, Sticky Keys. 

edit To change or modify. For example, 
to insert, remove, replace, or move text in 
a document. 

edition The data written to an edition container 
by a publisher. A publisher writes data to an 
edition whenever a user saves a document 
that contains a publisher, and subscribers in 
other documents may read the data from the 
edition whenever it is updated. See also 
publisher, subscriber. 

Edit menu A menu that contains editing 
commands such as Copy, Cut, and Paste. 

Enter key A key that notifies the application 
that the user is through entering information in a 
particular area of the document, such as a field in 
a database record. The user can also press the 
Enter key (like the Return key) to dismiss dialog 
boxes and alert boxes. 
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ergonomics The science of designing work 
environments that allow people and products to 
interact efficiently and safely. Examples include 
screen ergonomics and workplace ergonomics. 
Sometimes called human engineering. 

Escape key A key that allows the user to 
quickly get out of a situation while working on 
a computer. In many applications, pressing the 
Escape key allows the user to stop an operation 
in progress. The user can also press the Escape 
key as an alternate to clicking the Cancel button 
in a dialog box. 

event-driven Describes a kind of program that 
responds to user input in real time by repeatedly 
testing for events posted by interrupt routines. 
An event-driven program does nothing 
until it detects an event such as a click of the 
mouse button. 

extension A software program that adds some 
feature to the operating system. 

field A data item separated from other data 
by blanks, tabs, or other specific delimiters. 
A particular type or category of information 
in a database. 

file . Any named, ordered collection of 
information stored on a disk. Application 
programs and operating systems on disks are 
files as well as documents that users create. 
A Macintosh file consists of a data fork and a 
resource fork. See also document. 

File menu A menu that contains commands 
that affect whole documents such as Open, Save, 
Print, and Quit. 

file server A combination of controller software 
and a mass-storage device that allows computer 
users to share common files and applications 
through a network. A file server on an AppleTalk 
network system typically consists of a Macintosh 
computer with AppleShare software and one or 
more hard disks. 

Finder The application that maintains the 
Macintosh desktop and starts up other programs 
at the request of the user. The user uses the 
Finder to manage documents and applications, 
and to get information to and from disks. 
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fixed-point method A method for extending a 
continuous selection of text, using Shift-click, 
which extends the selection on either side (but not 
both) of a fixed point. Compare additive method. 

folder A holder of documents, applications, 
or other folders on the desktop. Folders act as 
subdirectories, allowing users to organize 
information in any way they want. 

font A complete set of characters in one design, 
size, and style. In traditional typography usage, 
fonts may be restricted to a particular size and 
style or may comprise multiple sizes, or multiple 
sizes and styles, of a typeface design. 

Font menu A menu that contains text fonts, 
such as Geneva and Chicago, available on a 
system (residing in a user's System Folder). 
See also font. 

font size The size of a font of characters in 
points; equivalent to the distance between the 
ascent line and the descent line of one line of text. 
Examples of font size are 12 point and 18 point. 

font style A set of stylistic variations other than 
size, such as italic, bold, and underline. · 

Forward Delete key A key on the Apple 
Extended Keyboard that causes the character 
to the right of the insertion point to be deleted 
in left-to-right systems. The insertion point does 
not move: the characters to its right are 
"vacuumed" in toward it as each is deleted. 
Compare Delete key. 

graphics Information presented in the form of 
pictures or images. Compare text. 

grow region A window region, usually within 
the content region, where dragging changes the 
size of an active window. 

0 

Help menu The menu directly to the left of the 
Application menu in the menu bar, indicated by 
a help balloon symbol, which contains on-screen 
help information. (Users can turn on Balloon 
Help from the Help menu.) 

hierarchical menu A menu in which one or 
more individual menu items can themselves 
contain a submenu. 

highlight To make something visually 
distinct, typically when it's selected. Usually 
done by reversing black and white areas or by 
darkening colors. 

hot spot The portion of the pointer that must be 
positioned over a screen object before mouse 
clicks can have an effect on that object. 

hot zone The area that the pointer's hot spot 
much be within in order for mouse clicks to have 
an effect. 

icon A symbol that graphically represents 
an object or a concept. Screen icons represent 
such objects as disks, documents, tools, and 
application programs. Icons on the outside of the 
computer can be used to show where to plug 
cables, such as the disk drive icon on the back 
panel that marks the disk drive connector. 

Info window The window that appears when 
you select an icon and choose Get Info from the 
File menu. It supplies information such as size, 
type, and date, and it includes a comment box for 
adding information. 

input Information transferred into a computer 
from some external source, such as the keyboard, 
a disk drive, or a modem. Compare output. 

input device A device that sends information 
to the microprocessor. The mouse and keyboard 
are the Macintosh computer's primary input 
devices. Compare output device. 

insertion point The position where text 
will be inserted, usually marked by a blinking 
vertical bar. 

Installer A utility program that users can use to 
update system software or add resources. 

invert To highlight by changing white pixels to 
black and vice versa. 

keyboard equivalent Keystrokes that invoke a 
menu item from the keyboard. A keyboard 
equivalent is usually the combination of a 
modifier key and a character key. 

keyboard layout Software that specifies the 
mapping of keys on a physical keyboard to 
character codes. 
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Keyboard menu A menu, located between 
the Help menu and the Application menu icons 
in the menu bar, that contains script system, 
keyboard layout, and input method items. It 
appears when more than one script system is 
installed and enabled or when a localizable 
flag is set. 

keyboard shortcut A keystroke that you can 
use instead of a mouse action to perform a task. 
For example, pressing the Command and the X 
keys at the same time is the same as choosing the 
Cut command from the Edit menu. 

little arrows A control, consisting of two 
arrows pointing in opposite directions, that 
allows users to increase or decrease values in a 
series by clicking or pressing the arrows. 

localization The process of adapting software 
to a particular region, language, and culture. 
Script and language adaptations are necessary 
but not sufficient for this process. Localization 
also includes date and time formats, number 
formats, text behavior formats, keyboard 
resources, and fonts. 

locked file A file whose data cannot be 
changed. 

Macintosh Operating System The combination 
of ROM-based and disk-based routines that 
together perform basic tasks such as starting the 
computer, moving data to and from disks and 
peripheral devices, and managing memory space 
in RAM. 

Macintosh user interface The standard 
conventions for interacting with Macintosh 
computers. The interface ensures users a 
consistent means of interacting with all 
Macintosh computers and the applications 
designed to run on them. 

main event loop In a standard Macintosh 
application program, a loop that repeatedly calls 
the Event Manager to get events and then 
responds to them as appropriate. 

mainstreaming programs Educational 
programs in which children with special needs 
(including those with physical disabilities) are 
included in "mainstream" classes with children 
who don't necessarily have special needs. 
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menu A list of choices presented by a program. 
In the desktop interface, menus appear when 
users point to and press menu titles in the menu 
bar. Dragging through the menu and releasing 
the mouse button while a command is 
highlighted chooses that command. 

menu bar The horizontal strip at the top of the 
screen that contains menu titles. 

menu item A choice in a menu, usually a 
command to the current application. 

menu title A word, a phrase, or an icon in the 
menu bar that designates a menu. Pressing on the 
menu title causes the title to be highlighted and 
its menu to appear below it. 

modal dialog box A dialog box that puts the 
user in the state or "mode" of being able to work 
only inside the dialog box. (A modal dialog box 
resembles an alert box.) The user cannot move a 
modal dialog box, and the user can dismiss it 
only by clicking its buttons. Compare modeless 
dialog box and movable modal dialog box. 

modeless dialog.box A dialog box that looks 
like a document window without a size box or 
scroll bars. The user can move a modeless dialog 
box, make it inactive and active again, and close 
it like any document window. Compare modal 
dialog box and movable modal dialog box. 

modifier key A key on a keyboard that 
changes the behavior or action of a character key 
when pressed at the same time as the character 
key. A modifier key can also change or accentuate 
the meaning of a mouse action. Compare 
character key. 

movable modal dialog box A modal dialog box 
that has a title bar (with no close box) that allows 
the user to move .the dialog box. Compare 
modeless dialog box. 

monitor See video monitor. 

monochrome monitor A monitor capable of 
displaying in only one color. 

mouse button The button on the top of the 
mouse. In general, pressing the mouse button 
initiates some action on whatever is under the 
pointer, and releasing the button confirms 
the action. 
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Mouse Keys An Easy Access feature that lets 
users use keys on the numeric keypad to control 
the pointer. 

mutually exclusive attribute group A group of 
attributes of which only one attribute can be in 
effect at any time. For example, the Left, Center, 
and Right commands in a graphics menu are 
a set of three commands, only one of which 
can be in effect at any time. (In dialog boxes, 
mutually exclusive attributes are represented 
by radio buttons.) Compare accumulating 
attribute group. 

network A collection of interconnected, 
individually controlled computers, together with 
the hardware and software used to connect them. 
A network allows users to share data and 
peripheral devices such as printers and storage 
media, to exchange electronic mail, and so on. 

operating system Low-level software that 
controls a computer by performing basic tasks 
such as input/ output, memory management, and 
interrupt handling. 

Option key A modifier key that gives a 
different meaning or action to another key 
or to a mouse action. 

outline font A collection of outline glyphs in a 
particular typeface and style with no size 
restriction. The Font Manager can generate 
thousands of point sizes from the same TrueType 
font. See also TrueType font. 

outline triangle A control that allows users 
to view the contents of a folder without opening 
it. (The triangles appear when the user chooses 
to view the contents of their file system in a 
list view.) 

output Information transferred from a 
computer to some external destination, such as 
the display screen, a disk drive, a printer, or a 
modem. Compare input. 

output device A device that receives 
information from the microprocessor. The 
monitor is the Macintosh computer's primary 
output device. Compare input device. 

palette The name for a tear-off menu when it's 
been torn off. A palette remains visible on the 
screen so you can use it without having to pull 
down the menu. A palette can also be part of a 
window that provides tools or choices such as 
colors or patterns. 

password A unique word or set of characters 
used to ensure security. For example, a user 
enters a password to log on to a volume on a 
file server. 

paste To place the contents of the Clipboard­
whatever was last cut or copied-at the 
insertion point. 

peripheral card A removable printed-circuit 
board that plugs into one of the computer's 
expansion slots, allowing the computer to use a 
peripheral device or to perform some subsidiary 
or peripheral function. 

peripheral device A piece of hardware-such 
as a video monitor, disk drive, printer, or 
modem-used in conjunction with a computer 
and under the computer's control. Peripheral 
devices are often (but not necessarily) physically 
separate from the computer and connected to it 
by wires, cables, or some other form of interface. 
Such devices sometimes require peripheral cards. 

pixel Short for picture element; the smallest dot 
you can draw on the screen. Also a location in 
video memory that corresponds to a point on the 
graphics screen when the viewing window 
includes that location. In the Macintosh 
monochrome display, each pixel can be either 
black or white, so it can be represented by a bit; 
thus, the display is said to be a bitmap. For color 
or gray-scale video, several bits in RAM may 
represent the image. Thus, the display is not a 
bitmap but rather a pixel map. 

pixel map A set of values that represents the 
positions and states of the set of pixels making 
up an image. 

point (1) A unit of measurement for type. 
Twelve points equal 1 pica, and 6 picas equal 1 
inch; thus, 1 point equals approximately 1172 
inch. (2) The intersection of a horizontal grid line 
and a vertical grid line on the coordinate plane, 
defined by a horizontal and a vertical coordinate. 

369 



GLOSSARY 

pointer A small shape on the screen that 
follows the movement of the mouse or shows 
where the user's next action will take place. 
The pointer can be an arrow, an I-beam, a 
crossbar, a wristwatch, or other appropriate 
image. Called the cursor in Macintosh technical 
manuals. See also insertion point. 

pop-up menu A menu not located in the menu 
bar, which appears when the user presses the 
mouse button in a particular place. 

progressive disclosure A technique by 
which the most common options are presented in 
a simple interface and additional choices or 
information are disclosed by activating 
some control. 

publisher A portion of a document that makes 
its data available to other documents or 
applications. A publisher stores its data in an 
edition whenever a user creates or edits the data 
in the publisher and then saves it. See also 
edition and subscriber. 

pull-down menu A menu that is hidden until 
you move the pointer to its title and press the 
mouse button. 

radio button A standard Macintosh control 
that displays a setting, either on or off, and is 
part of a group in which only one button can be 
on at a time. 

Read Me document A plain text document that 
is included on application and system software 
disks and provides late-breaking information 
about the product. 

resource Data or code stored in a resource file 
and managed by the Resource Manager. 

Return key A key that causes the cursor or 
insertion point to move to the beginning of 
the next line. It's also used in some cases to 
confirm a command and to dismiss dialog boxes 
and alert boxes. 
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RGB Abbreviation for red-green-blue; a method 
of displaying color video by transmitting the 
three primary colors as three separate signals. 
There are two ways of using RGB with 
computers: TTL RGB, which allows the color 
signals to take on only a few discrete values; and 
analog RGB, which allows the color signals to 
take on any values between their upper and 
lower limits, for a wide range of colors. 

RGB monitor A type of color monitor that 
receives separate signals for each color (red, 
green, and blue). 

saturation A measurement of how much white 
a color contains-the less white, the more 
saturated the color. 

save To store information by transferring it 
from main memory to a disk. Work not saved 
disappears when you switch off the computer or 
when the power is interrupted. 

screen The part of the monitor where 
information is displayed. Also called 
display screen. 

script A writing system, such as Cyrillic or 
Arabic. The English language uses Roman script. 

script system A collection of software facilities 
that provides for basic differences between 
writing systems, such as character sets, fonts, 
keyboards, text collation, and word breaks. 
Examples of script systems are Roman, Japanese, 
Arabic, Traditional Chinese, Simplified Chinese, 
Hebrew, Greek, Thai, and Korean. 

scroll To move a document or directory in its 
window so that a different part of it is visible. 

scroll arrow An arrow at either end of a scroll 
bar. Clicking a scroll arrow moves a document or 
directory one line. Pressing a scroll arrow moves 
a document continuously. 

scroll bar A rectangular bar that may be along 
the right or bottom of a window. Clicking or 
dragging in the scroll bar causes the view of the 
document to change. 

scroll box The solid box in a scroll bar. The 
position of the scroll box in the scroll bar 
indicates the position of what's in the window 
relative to the entire document. 



~LOSSARY 

See Files The AppleShare file server access 
privilege that gives the right to open and copy 
documents and applications in a folder. 

See Folders The AppleShare file server access 
privilege that gives the right to see folders within 
a folder. 

select To designate where the next action will 
take place. To select using a mouse, you click an 
icon or drag across information. 

selection A series of characters, or a character 
position, at which the next editing operation 
will occur. Selected characters in the active 
window are inversely highlighted. Also called 
selection range. 

shared resource A resource, such as a 
document, an application, or a storage medium, 
that is being used, often simultaneously, by a 
group of users on a computer network. 

Shift-click To click while the Shift key is down. 
Shift-clicking extends or shortens a selection. 

Shift-drag To drag while the Shift key is 
down. Shift-dragging allows users to select 
multiple objects. 

Shift key A key that, when held down, causes 
the subsequent letter typed to appear in 
uppercase or the top symbol on a two-character 
key to be produced. The Shift key can also 
modify mouse actions. See also Shift-click, 
Shift-drag. 

size box A box in the lower-right corner of 
some active windows. Dragging the size box 
resizes the window. 

Size menu A menu that contains sizes, 
measured in points, for fonts. 

slider A control that graphically represents the 
ranges of values that a user can set or that simply 
displays the value, magnitude, or position of 
something. Also called a dial. 

Slow Keys An Easy Access feature that lets the 
user set a delay before each keystroke is accepted 
by the computer. 

Space bar The long, unlabeled bar along 
the bottom of the keyboard that generates a 
space character. 

space character A text character whose printed 
representation is a blank space. Generated by 
pressing the Space bar. 

split bar A control appearing in a scroll bar that 
allows users to split a window into separate 
window panes. See also split line, window pane. 

split line The line, which appears when a user 
splits a window, that visually separates the 
resulting window panes. See also split bar, 
window pane. 

stack A HyperCard document. 

standard file dialog box A dialog box that 
allows users to perform actions (such as viewing, 
opening, and saving) on files residing on any 
type of storage media. Also allows users to view 
elements on their desktops. 

Standard File Package A Macintosh package 
for presenting the standard user interface when a 
file is to be saved or opened. 

standard state The initial size and location of a 
window. This state is determined by the 
application. 

Sticky Keys An Easy Access feature that lets 
the user type combination keystrokes without 
actually pressing the keys simultaneously. 

Style menu The menu that contains style 
attributes, such as bold, italic, and condense, 
for fonts. 

subscriber A portion of a document that 
automatically obtains current data from other 
documents and applications. A subscriber 
reads data from an edition. See also edition 
and publisher. 

system font The font that the system uses 
(in menus, for example). In Roman-based writing 
systems, the system font is 12-point Chicago. 

TeachText An application that lets you open 
text and graphics documents, particularly if the 
original application that created the document is 
not available. 
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tear-off menu Any menu that you can detach 
from the menu bar by pressing the menu title and 
dragging beyond the menu's edge. The torn-off 
menu appears in a window or a utility window 
on the desktop. Once torn off, these menus are 
called palettes. 

text Information presented in the form of 
readable characters. Compare graphics. 

text box The place or places in a dialog box 
where information can be typed. Also called text 
entry field. 

TextEdit The part of the Toolbox that supports 
basic text entry and editing capabilities of a 
standard Macintosh application. 

text entry field An area, usually a rectangular 
box, located in a dialog box and into which the 
user enters text to identify something, such as the 
name of a document. 

toggled menu item A menu item that has two 
states. The menu item changes from one state to 
the other each time a user chooses it. 

tokens (1) An abbreviation of a string of 
characters. (2) A sequence of characters delimited 
so as to be indentified by a compiler. 

TrueType font A type of outline font 
supplied with Macintosh system software. 
See also outline font. 

type-ahead The process by which the computer 
stores keystrokes (typed faster than the computer 
can process) in a queue for later processing. 

type selection The ability to select an item from 
a list of items by typing the beginning character 
or characters of its name. 

user interface The rules and conventions by 
which a computer system communicates with the 
person operating it. 

user state The size and location a user sets 
for a window. 

utility A type of software that helps people 
manage the computer environment. 
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utility window A type of box that has some but 
not all features of a regular window. A utility 
window has a bar at the top by which it can be 
dragged and a close box, but does not necessarily 
have a title, and is nonscrolling. Also called a 
miniwindow. Compare palette. 

value An item of information that can be stored 
in a variable, such as a number or a string. 

video monitor A display device that can 
receive video signals by direct connection and 
cannot receive broadcast signals such as 
commercial television; it can be connected 
directly to the computer. 

window An object on the desktop that presents 
information such as a document or message. 
Each window is internally represented in a 
window record. 

window pane A part of a window after it has 
been split into two or more parts 

word processor An application program that 
provides tools for creating, editing, and 
formatting text. 

word wrap The automatic continuation of text 
from the end of one line to the beginning of the 
next without breaking in the middle of a word. 

zoom box A small box with a smaller box 
enclosed in it found on the right side of the title 
bar of some windows. Clicking the zoom box 
toggles the window between the standard state 
and the user state. 
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16-by-16 pixel (small) icons 234, 244-245, 252 
32-by-32 pixel (large) icons 234 
45-degree angles in icon design 231 
4-bit color icons 234 
80 percent solution 35 
8-bit color icons 234 

A 

About command 98 
accessibility 14 
access privileges 28 
access to help systems 315 
accumulating attribute groups 65 
activating windows 155 
active-application icon, as correct term 307 
active area in dialog boxes 199 
active keyboard 125 
active windows 135 

and dialog box positions 150-151 
using color to distinguish 135 

adev, correct terminology for 307 
aesthetic integrity, as design principle 11-12 
alert boxes 

and ellipsis character in menus 70 
appearance of 194 
as special case of modal dialog box 189 
caution 195 
closing 194 
color in 177 
compared with other dialog boxes 177 
default display positions of 150-152 
defined 193 
layout of 196 
location of buttons in 197 
note 194 
providing feedback in 9 
save changes 102-104, 201-202 
stop 196 
types of 194-196 
warning of data loss in 195 
worldwide issues and 197 

alignment of elements in dialog boxes 20-22 
alternating icons in menu bar 71-72 
ambiguous command names 77 

American Heritage Dictionary 306 
anti-aliasing in icons 243-244 
Apple icon color set 240-241 
Apple menu 98 
Apple Menu Items folder 98 
Apple Publications Style Guide 306 
Apple reserved keyboard equivalents 128-129 
applicationicons 246 
Application menu 71-72, 127 

alternating icon in 71-72 
background notification techniques and 71-72 

application menu titles 54 
applications, naming in dialog box messages 199 
Apply button 209 
arrays 

and arrow keys 281 
defined 288 
discontinuous selection in 292, 299 
navigating with the Tab key 299 
Return key and 299 
selecting in 298-299 
Tab key and 299 

arrow keys 281-284, 295-296 
and modifier keys 282-284 
and scroll bars 281 
selecting with 295-296 

arrow pointer 270 
ascent line for fonts 24 
attribute groups in menus 61, 64-66 
audible notifications 72 
audience 13-14. See also users 
augmentative and assistive communication 27 
automatic scrolling 166-167 
auto-repeat 280 

B 

background operations and movable modal dialog 
boxes 187 

Backspace key. See Delete key 
Balloon Help 125, 316-325 
balloons. See help balloons 
bit depths of monitors 235 
bitmap-based graphics 297 
bitmapped fonts 123 
black-and-white design, and color 263-264 
black-and-white icons, designing 238, 254 
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blue in color design 265 
borders 
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for active scrolling lists 198 
for icons 239 

button names 
Apply 209 

buttons. See also radio buttons 
balloons for 319 
behavior of 205-206 
capitalization of names of 206 
default 206 
defined 204 
Dialog Manager and 205, 206 
feedback and 205 
in caution alert boxes 195 
in modal dialog boxes 188-189 
in modeless dialog boxes 180 
in movable modal dialog boxes 185 
in note alert boxes 194 
in stop alert boxes 196 
labels for 310 
names of 102, 206-209 
placement of in alert boxes 197 
size of 205 
standard height of 205 

c 
calendars, variations in worldwide 17 
Cancel button 207-208 
Cancel Publisher button 119 
Cancel Subscriber button 120 
capitalization of interface elements 309 
Caps Lock key 279 
caution alert boxes 195 
cdev, correct terminology for 307 
character keys 275-278 
characters in menus 64-72 
checkboxes 

balloons for 322 
balloons for groups of 322 
choices in 213 
defined 211 
labels for 212-213, 309-310 
use of terminology with 308 
versus pop-up menus 85-86 

checkrnarks in menus 64-66 
Chicago Manual of Style 306 
Chooser extension, as correct term 307 
Chooser extension icons 251 
choosing menu items 56-57 
Clear command (Edit menu) 117 
Clear key 277 
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clicking 
and selecting 289 
Command-clicking 291-292 
components of 271 
correct terminology for 308 
Shift-clicking 289-291 
use of 271 

Clipboard 112 
close boxes 134, 180, 186 
Close command (File menu) 102-104 
closing 

alert boxes 194 
menus 56 
modal dialog boxes 188 
modeless dialog boxes 180 
movable modal dialog boxes 185 
windows 102, 152-154 

collaborative computing 27-31 
colons in dialog boxes 312 
color 258-265 

and black-and-white design 263-264 
and progressive disclosure 262 
and small objects 265 
and standard interface elements 258-260 
choices of for windows 137 
degradation of across monitors 241 
for categorizing information 265 
in alert boxes 177 
in icon design 240-242 
in modeless dialog boxes 177 
in movable modal dialog boxes 177 
number of in designs 264 
pattern substitutions for keyboard icons 254 

Color control panel 259 
color-deficient vision 25 
color icons 238-243 

labeling mechanism for 242-243 
selection mechanism for 241-242 

color palettes 262 
color tables 264 
column selection in arrays 298 
Command-/ 285 
Command-? 285 
Command-clicking 291 
Command key. See also keyboards 

and arrow key combinations 128, 283-284 
combinations 128-129,280,282-284 
labels on 280 

Command key equivalents. See keyboard equivalents 
Command-Left Arrow 128, 282-284 
command-line interfaces, and pointers 269 
Command-modifier key-Space bar 128-129 
Command-Option-Space bar 128 
Command-Right Arrow 128, 282-284 
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commands, menu 
About (Apple menu) 98 
Clear (Edit menu) 117 
Close (File menu) 102-104 
Copy (Edit menu) 115 
Create Publisher (Edit menu) 117-118 
Cut (Edit menu) 114 
Find (File menu) 67 
for Edition Manager 110-111 
Get Info (File menu) 69 
New (File menu) 99-100 
Open (File menu) 101-102 
Page Setup (File menu) 108 
Paste (Edit menu) 115-116 
Print (File menu) 108--109 
Publisher/Subscriber Options (Edit menu) 118--120 
Quit (File menu) 99, 109 
Reduce to Fit 157 
Revert (File menu) 107 
Save (File menu) 104-105 
Save As (File menu) 106--107 
Select All (Edit menu) 117 
Show Clipboard/Hide Clipboard 

(Edit menu) 112, 117 
Subscribe To (Edit menu) 118 
Undo/Redo (Edit menu) 113--114 

Command-Space bar 128--129 
communications with other users 30 
complexity of interface design 35-38 
conceptual space on multiple monitors 156 
concurrent help systems 314 
consistency 

as design principle 7-8 
in use of icon elements 233 
within icon families 233, 245 

context as a clarifying tool 228 
context clues for communication 30 
context-sensitive help 314 
control definition functions 259 
Control key 280 
control panels 

Color 259 
Mouse 272 
providing icons for 251 
Sound 26 

controls 
alignment of 20 
buttons 204-209 
checkboxes 211-213 
defined 204 
help balloons for 318 
in document windows 134 
in scroll region 161, 162 
little arrows 216--217 
not supported by the Macintosh Toolbox 214-218 

outline triangle 218 
radio buttons 210-211 
scrolling lists 220-221 
sliders 214-215 
standard toolbox 204-213 
text-entry fields 219-220 

Copy command (Edit menu) 115 
Create Publisher command (Edit menu) 117-118 
crosshairs pointer 270 
cultural values 17 
cursors 269 
custom icons 245-255 

for applications 246-247 
for control panels 251 
for documents 247 
for editions 250 
for extensions 251 
for keyboards 252-255 
for preferences 250 
for query documents 249 
for stationery pads 248--249 

Cut command (Edit menu) 114 

D 

DA, correct terminology for 307 
dashes in menus 64-66 
database extension, as correct term 307 
data encryption 30 
data loss and alert boxes 195 
dates 17 
ddev, correct terminology for 307 
deaf people. See hearing disabilities 
default color tables 264 
default icons 245-255 

for applications 246 
for documents 247 
for editions 250 
for extensions 250 
for keyboards 252 
for query documents 249 
for stationery pads 249 

Del (Forward Delete) key 285 
Delete (Backspace) key 277 
deleting 

text 300 
using the Cut command 114 

design principles 4-14 
desk accessory, as correct term 307 
desktop metaphor 5 
desktop pattern and icons 239 
diacritical marks 24 
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dialog boxes 176-202. See also alert boxes 
alignment of elements in 20-22 
and ellipsis character in menus 68-70 
and pop-up menus 82, 83-85 
as windows 176 
color design for 258 
default display positions in 150-152 
dismissing with the Return key 276 
for font size 123 
keyboard input in 198-199 
messages in 199, 310-312 
modal 188-193 
movable modal 185-188 
position in window display order 144 
preferences and 38 
Print 108-109 
providing feedback in 9 
Publisher Options 118-120 
SaveAs 106-107 
standard file 101, 200 
Subscriber Options 118-120 
type selection in 198 

dialog box messages, how to write 310-312 
Dialog Manager 191, 192 
diamond mark in Application menu 71-72 
dimmed items in menus 60 
direct manipulation 6, 226 
directory dialog box, as correct term 307 
disabilities 24-27. See also universal access 

hearing 26 
physical 25 
seizure disorder 27 
speech and language 27 

discontinuous selections 291, 299 
dividers in menus 62-63 
documentation 

avoiding jargon in 307,313 
learning paths in 313 

document icons 247-248 
document names in dialog box messages 199 
documents. See also windows 

and outline triangles 218 
and windows 132 
defined 308 
names of and window titles 142-143 
opening 101-102 

document windows. See windows 
Done button 208 
dots in menus. See ellipsis character 
double-clicking 272-273 
dragging 274,289 
duplicating data 115 

376 

E 

editing 
in fields 302-303 
passwords 29 
shared information 30 
text 300-303 

edition icons 250 
Edition Manager commands 110-111, 117-120 
Edit menu 109-120, 187-188, 191-192 

adding commands to 110 
and modal dialog boxes 191 
and movable modal dialog boxes 187-188 
Clear command in 117 
Clipboard and 111-112 
Copy command in 115 
Create Publisher command in 117-118 
Cut command in 114 
Edition Manager commands in 110-111, 117-120 
Paste command in 115-116 
Publisher /Subscriber Options command in 118-120 
Select All command in 117 
Show Clipboard/Hide Clipboard command in 117 
Subscribe To command in 118 
Undo/Redo command in 113-114 

electronic documentation help systems 314-316 
ellipsis character 

and modeless dialog boxes 180 
as subpalette indicator 39 
in menus 67-70 

empty documents and the insertion point 282 
End key 285 
entering data 

with the Enter key 275 
with the Return key 276 

Enter key 275 
error checking in modeless dialog boxes 182 
error messages, how to write 311 
Escape (Esc) key 277 
extension icons 250 

F 
F (function) keys 164, 284-286 
feature cascade 35 
feedback 

and asynchronous operations 56 
and changes in modeless dialog boxes 182 
and selecting 286 
and the Escape key 278 
and windows 133 
during long operations 271 
in menus 56-57 
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feedback and dialog, as design principle 9-10 
fields, text entry 219-220 
fields in arrays 288, 298-299 
file, use of term 308 
File menu 67, 69, 99-109 

Close command in 102-104 
Find command in 67 
Get Info command in 69 
New command in 99-100 
Open command in 101-102 
Page Setup command in 108 
Print command in 108-109 
Quit command in 99, 109 
Revert command in 107 
Save As command in 106-107 
Save command in 104-105 

file types, user terms for 307 
Find command (File menu) 67 
Findericonfamilies 234-236 
Finder icon family editor 240 
FKEY, correct terminology for 307 
flags for keyboard icons 253-254 
flashing the menu bar 26 
flexibility 

and modeless dialog boxes 178 
and movable modal dialog boxes 178, 187 
and using modal dialog box for temporal status 190 

flicker frequencies 27 
floating windows on desktop 145 
font icons 252 
Font menu 120-122 
fonts 

in pop-up menus 88-89 
worldwide compatibility and 23-24 

font size dialog box 123 
forgiveness, as design principle 10 
Forward Delete (Del) key 285 
function key, as correct term 307 
function keys 164, 284-286 
fuzzy appearance of icons 244 

G 

Get Editions radio button 120 
Get Info command (File menu) 69 
glyphs 23-24 
grammar and localization 19 
graphic language 8, 12 
graphics 

and cultural values 17 
defined 288 
selecting 297 

gray area of scroll bar 158, 164 
gray background and color 265 
grouping items in menus 60-62 

H 

hand element in application icons 246 
handicaps. See universal access 
hardware 

icons to represent 236 
indicator lights on 26 
latches on 25 

hearing disabilities 26 
help balloons 316-325 

for buttons 319 
for checkboxes 322 
for controls 318 
for groups of checkboxes 322-323 
for groups of radio buttons 322-323 
for icons 324 
for menu items 320 
for menu titles 320 
for modal dialog boxes 324 
for pop-up menus 320 
for radio buttons 321 
for states of menus 317 
for text entry boxes 325 
for tools in palettes 323 
for window parts 324 
how to write 318-319 
length of messages in 317, 318 
when to use 317-318 

Help key 285 
Help menu 125 
help systems, online 314-316 
Hide Clipboard/Show Clipboard command 112, 117 
hierarchical menus 79-82 
hierarchical pop-up menus, avoiding 86 
highlighting, color design for 260 
Home key 285 
hotspot 270 
hotzone 270 
human interface design principles. See principles of 

human interface design 
human interface design process 

and 80 percent solution 35 
and feature cascade 35 
and features inspired by market pressures 34 

humor and icons 230 
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I-beam pointer 270 
icon families 234-236 
icon masks 244 

INDEX 

icons 224-255. See also icon families 
4-bit color 235 
8-bit color 235 
against the desktop pattern 239 
and humor 230 
anti-aliasing in 243-244 
balloons for 324 
black-and-white 238 
color degradation of 241 
consistent use of elements in 233 
conventions for types of documents and 247-248 
design process for 236-237 
for control panels 251 
for edition files 250 
for extensions 250 
for movable resources 252 
for page layout documents 248 
for PICT files 248 
for preferences files 250 
for query documents 249 
for representing actions 228 
for text-only documents 248 
in Application menu 71-72 
in Keyboard menu 126-127, 252, 255 
keyboard 22, 126-127,252-255 
label text for 228 
large (32-by-32 pixel) 234 
limitations of 227-228 
masks for 234,244 
outlines of 239 
selection mechanism for 238 
sizes of 234-236 
small (16-by-16 pixel) 234 
stationery pad 249 
suites of 235 
three-dimensional effects in 231 
to represent hardware devices 236 
use of metaphors in 229 
versus verbal representations in 224 

icon suites 235 
inactive scroll bars 160 
inactive windows, moving 155 
indicators 

for subpalettes 39-40 
in hierarchical menus 79 
in pop-up menus 87 
in scrolling menus 78 

informal user observations 43-46 
INIT, correct terminology for 307 
input devices and accessibility 14 
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input methods, for double-byte scripts 22 
inserting copied information 115 
inserting text 300 
insertion point 

and clicking 293 
and command-line interfaces 269 
defined 269 
moving 282 

intelligent cut and paste 301-302 
interface elements, standard 

and color design 258-260 
avoiding new behaviors for 39-40 

international keyboards 281 
International Standards Organization 281 

K 

keyboard equivalents 128-129 
keyboard icons 22, 126-127,252-255 

modification indicators in 254 
pattern substitution for color in 254 

keyboard input in dialog boxes 198-199 
keyboard layouts 22-23, 126-127 
Keyboard menu 22, 125-127 
keyboard resources 125-127 
keyboards 126,275-286 
keys 

arrow 281-284, 295-296 
Caps Lock 279 
character 275-278 
Clear 277 
Command 
Control 280 
Delete (Backspace) 277 
End 285 
Enter 275 
Escape (Esc) 277 
Forward Delete (Del) 285 
function 284-286 
Help 285 
Home 285 
modifier 278-280,282-284 
Option 279, 282-283 
Page Down 286 
Page Up 286 
Return 276, 299 
Shift 278, 299 
Tab 276,299 

knowledge of your audience 13-14 
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L 
labels 

and pop-up menus 87 
color for in icons 242-243 
color labeling for icons 242 
for checkboxes 212-213 
for icons 228 
for interface elements 309-310 
for little arrows 216 
on keyboards 281. See also names 

language disabilities 27 
language in the interface 306--325 
large (32-by-32 pixel) icons 234 
learning paths for users 313 
lights on hardware 26 
light source on Macintosh screen 232, 262 
little arrows 216--217 
localization 14, 16--24 

of documentation 314 
oficons 230 
text operations and 19-20 
translating text and 18--19 
using resources to facilitate 17 

look and feel of interface elements 39 

M 
Macintosh script management system 16 
Macintosh Toolbox, controls not supported by 214-218 
market pressures, features inspired by 34 
masks, icon 244 
maximum window size 156 
menu bar 

flashing as notification 26 
menu bar access 

Dialog Manager and 191-192 
from modal dialog boxes 191-192 
from movable modal dialog boxes 187-188 

menu bars 52-55 
and modal dialog boxes 57 
and standard menus 52 
size of 52-53 
use of space in 52-53 
width of 53 

menu commands. See commands, menu 
menu elements 58--60 
menu items 

balloons for 320 
capitalizing 59 
choosing 56 
hierarchical 79-82 
labels for 309 

names of 58--60 
toggled 73, 75-77 
unavailable 60 

menus 50-129,260 
Apple 98 
Application 127 
attribute groups in 64-66 
behavior of 55-57 
checkmarks in 64-66 
closing 56 
color design for 260 
dashes in 64-66 
dividers in 62-63 
Edit 109-120 
ellipsis character in 67-70 
feedback about actions in 56--57 
File 99-109 
Font 120-122 
fonts used in 60 
grouping items in 60-62 
Help 125 
hierarchical 79-82 
highlighting titles of 56, 57 
Keyboard 22-23,125-127 
nonstandard elements in 72 
opening 56 
pop-up 82-92 
scrolling 78--79 
Size 122-123 
standard characters in 64-72 
standard Macintosh 98--127 
standard pop-up 87-91 
Style 73-75, 124 
tear-off 93-95 
text styles in 73-74 
titles of 54 
type-in pop-up 91-92 

menu titles 
balloons for 320 
choosing 310 

messages 
in dialog boxes 199, 310-312 
in help balloons 317, 318--319 

metaphors 
consistency of 8 
use of as design principle 4-5 
use of for icons 229 

minimum window size 156 
miniwindows 309 
modal dialog boxes 57, 177, 188--193, 324 

and balloons when on the screen 324 
appearance of 190 
behaviors of 191-193 
buttons in 188 
closing 188 
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modal dialog boxes (continued) 
closing 188 
compared with other dialog boxes 177 
Edit menu access to 191 
immobility of 188 
menu bar access 57 
menu bar access to 191-192 
stacking 192-193 
when to use 189-190 

ModalDialog procedure 205 
modeless dialog boxes 176, 178--184 

appearance of 180-181 
behaviors of 181-184 
changing attributes with 182-184 
closing 180-181 
color in 177 
compared to other dialog boxes 176 
comparing information in 178 
completing actions in 184 
dynamic nature of 184 
error checking in 182-183 
feedback and changes to 182 
intermediate security states of 183 
presetting values in 179 
titles of 180 
when to use 178 

modelessness, as design principle 12-13 
modification indicators for keyboard icons 254 
modifier keys 278--280, 282-284 
monitors 

and icon display 232, 235 
and window size 156 
multiple 

alert box positions in 152 
and work space 156 · 
and zooming 170 
dialog box positions in 152 
window positions in 148--150 

Monitors control panel 156 
mouse actions 271-274, 293 

clicking 271 
double-clicking 272-273 
dragging 274 
pointing 269 
pressing 273 
selecting 293 

Mouse control panel 272 
mouse devices 269 
movable modal dialog boxes 177, 185-188 

and background operations 187 
appearance of 186 
behaviors of 187 
closing 185 
color in 177, 188 
display order of on desktop 146 
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flexibility and 187 
menu bar access to 187-188 
when to use 178 

movable resource icons 252 
moving the pointer 269 
moving windows 154-155 
MultiFinder icon, correct terminology for 307 
multimedia effects in help systems 316 
multiple modifier-key combinations 283 
mutually exclusive attribute groups 64 

N 

names. See also labels 
of buttons 206-209 
of documents and window titles 142-143 
of interface elements 309-310 
of menu items 58--60 
of modeless dialog boxes 180 

network extension, as correct term 307 
networks 31 
New command (File menu) 99-100 
nonexclusive attribute groups 65-66 
non-Roman script systems 19 
nonstandard marks in menus 72 
note alert boxes 194 
notification techniques 71-72 
nouns as icons 228 
numbers in window titles 142 

0 
object-based graphics 297 
objects 

and clicking 272-273 
hot zone of 270 
moving by dragging 274 
selecting 286-299 

OK button 207 
online help systems 314-316 
Open command (File menu) 101-102 
opening 

documents 101-102 
menus 56 
pop-up menus 87 
windows 141-143 

Option-Delete 277 
Option-dragging to copy objects 279 
Option key 279, 282-283 
outline triangle 218 
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p 

Page Down key 164, 286 
page indicator in window frame 162 
page layout document icons 248 
Page Setup command (File menu) 108, 189 
Page Up key 164, 286 
palettes 92, 96-97 

and subpalettes 39 
and tracking feedback 96 
balloons for 323 
in window frames 97 
tool 96-97 

panes of windows 170-173 
passwords 30 
Paste command (Edit menu) 115-116 
pattern substitutions for keyboard icons 254 
perceived stability, as design principle 11 
physically impaired individuals 25 
PICT file icons 248 
plus sign pointer 270 
pointers 96, 260, 268-271 

and tools 96 
changing shape of 270 
color design for 260 
moving 269 
types of 270 

pointing devices 268-271 
pop-up menus 82-92 

and keyboard equivalents 86 
behavior of 83, 87-91 
fonts in 88-89 
standard 87-91 
type-in 91-92 
versus checkboxes 85-86 
versus radio buttons 85 
widthof 89 

preferences, implementing 37-38 
preferences icons 250 
pressing the mouse button 273 
principles of human interface design 4-14 

accessibility 14 
aesthetic integrity 11-12 
consistency 7--8 
direct manipulation 6 
feedback and dialog 9-10 
forgiveness 10 
knowledge of your audience 13-14 
modelessness 12-13 
perceived stability 11 
see-and-point 7 
use of metaphors 4-5 
user control 9 
WYSIWYG 8 

Print command (File menu) 108-109 

privacy and collaborative computing 28-30 
privileges for access, symbols for 28 
product development process 34-46 
product names in icons 236 
programming terms 307 
progressive disclosure 8, 35-37, 262 
protecting data 28-30 
Publisher Options dialog box 118-120 
Publisher I Subscriber Options command 

(Edit menu) 118-120 
punctuation in window titles 143 
push buttons. See buttons 

Q 

query document icons 249 
Quit command (File menu) 99, 109 
QWERTY transliteration of keyboard layouts 254 

R 

racing stripes in title bar 135 
radio buttons 210-211. See also buttons 

balloons for 321 
balloons for groups of 322-323 
defined 210 
labels for 309 
versus pop-up menus 85 

range selection 294-295, 299 
RDEV, correct terminology for 307 
read-only access 28 
Redo/Undo command (Edit menu) 113-114 
Reduce to Fit command 157 
references for usage and style 306 
remote resources 31 
repeating characters automatically 280 
replacing a selection 301 
ResEdit utility 240 
reserved keyboard equivalents 128-129 
Return key 276, 299 
reversible actions 10 
Revert command (File menu) 107 
Roman script system 19 

0 

s 
Save a Copy command, avoiding 107 
Save As command (File menu) 106-107 
save changes alert box 103-104, 201 

381 



INDEX 

Save command (File menu) 104--105 
screens. See monitors 
script management system 16 
Script Manager 16 
script systems 

and worldwide compatibility 16 
enabled 125 
icons for 125-127, 252 
keyboard handling of 22, 125 
Roman and non-Roman 19 

scroll arrows 158, 163 
scroll bars 158, 158-162 

and arrow keys 281 
and other controls in same region 161-162 
inactive 160 
in split windows 170-173 
versus sliders 215 

scroll boxes 158, 165 
scrolling lists 198, 220-221 
scrolling menus 78-79 
scrolling windows 158-167, 172 

automatically 166-167 
by position 165 
by unit 163 
by windowful 164 
panes of 172 

security of information 28-30 
security states and modeless dialog boxes 183 
see-and-point, as design principle 7 
seizure disorders 27 
Select All command (Edit menu) 117 
selecting 286-299 

and scrolling 166-167 
by clicking 271, 289 
by Command-clicking 291-292 
by double-clicking 272-273 
by dragging 274, 289 
by Shift-clicking 289-291 
color design for 260 
fields in an array 298-299 
graphics 297 
in arrays and tables 298-299 
ranges 294--295 
text 292 
with the arrow keys 295-296 
with the mouse 293 

selection mechanism 
for color icons 241-242 
for icons 238 

selections 
extending 167 
extending with Shift key 278 
replacing 301 

semantic modifiers 283 
shared computing environment 27-31 
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shared resources 28 
sharing information 27-31 
Shift-clicking 289-291 
Shift key 278, 299 
shortcuts. See also keyboard equivalents 

documenting in help systems 315 
double-clicking 272 

Show Clipboard/Hide Clipboard command 117 
in Edit menu 112 

size 
of menu bars 52-53 
of pop-up menus 89 

size boxes 134, 157 
Size menu 122-123 
sizes of icons 234-236 
sliders 214--215 
small (16-by-16 pixel) icons 233-234, 244--245 
small objects and color 265 
sound, as notification 72 
Sound control panel 26 
sound icons 252 
Speaker Volume control 26 
speech synthesizers, for people with a speech 

' disability 27 
split bars 170-171 
split lines 170-171 
splitting windows 170-173 
stack icons 248 
stacking modal dialog boxes 192-193 
stacks, HyperCard 308 
standard characters in menus 64--72 
standard file dialog boxes 101, 200 
standard file dialog boxes, correct terminology for 307 
standard interface elements 

and color design 258-260 
avoiding new behaviors for 39-40 

standard Macintosh menus 98-127 
standard save changes alert box 102-104, 201-202 
standard state of a window 168-170 
standard toolbox controls 204--213 
stationery documents, icons for 249 
status bar in window frame 162 
stepped interfaces 8 
stop alert boxes 196 
Stop button 208-209 
Style menu 

guidelines for 124 
text styles in 73-74 

style of language 306 
submenus 79-82 
subpalettes, indicators for 39-40 
Subscriber Options dialog box 118-120 
Subscriber /Publisher Options command 

(Edit menu) 118-120 
Subscribe To command (Edit menu) 118 
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suites of icons 235 
symbols 

in icons 224-226 
in menus 64-72 

synchronization of keyboards and fonts 125 
system beep 26 
system extension, as correct term 307 
system font, in menus 60 

T 

Tab key 276, 299 
tables 288, 298-299 
target audience 13-14. See also users 
task analysis, for defining your audience 13 
task-oriented documentation 313 
tear-off menus 93-95 
temporal status and modal dialog boxes 190 
terminology in the interface 307-309 
text 

and arrow keys 281-284 
and the insertion point 293 
as a type of object 287-288 
deleting 300 
editing 300-303 
handling of, and worldwide issues 19 
in dialog boxes 199 
inserting 300 
putting in resources 17 
selecting 292-296 
selections, extending 167 
selections, extending with Shift key 278 
sizes of 17 
translating 18-19 

text entry fields 
and Save As dialog boxes 219 
editing 302-303 
providing text-editing capabilities in 219 

text in icons 230 
text-only document icons 248 
text styles 73-74, 124 
think-aloud protocols 43 
three-dimensional effects in icons 231 
tilted document page in application icons 246 
title bars 134, 135 
titles. See also labels 

ofmenus 54 
of modeless dialog boxes 180 
ofwindows 142-143 

toggled menu items 73, 75-77 
tools, balloons for in palettes 323 
translating text 18-19 
transparency of networks 31 

triangles 
in hierarchical menus 79 
in pop-up menus 87 
in scrolling menus 78 

triple-clicking 273 
True Type fonts 123. See also fonts 
tutorials 313, 315 
two-dimensional designs 263 
type-ahead 280 
type-in pop-up menus 91-92 
type selection in scrolling lists 198 

u 
Undo/Redo command (Edit menu) 113-114 
universal access 14, 24-27 
untitled documents 101-102 
untitled windows 142-143 
uppercase characters and the Shift key 278 
usability testing 41-46, 315 
user choices in pop-up menus 85-87 
user control, as design principle 9 
user input, restricting with modal dialog boxes 189 
user observations, steps for conducting 43-46 
users. See also audience 

anticipating their questions in help systems 315 
documentation for 313-314 
identifying in collaborative computing 28 
meeting expectations of 8 
with a disability 24-27 

user state of a window 168-170 
utility windows 137-138, 145, 309 

display order of on desktop 145 
terminology for 309 

v 
views of documents. See windows 
visual disabilities 25 
visual feedback and collaborative computing 30 

W,X,Y 

width of menu bar 53 
windoid, correct terminology for 309 
window boundaries 274 
window definition functions 177, 259 
window frames 134 
window panes 170-173 
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windows 132-173. See also win,dow panes 
activating 155 
and dialog boxes 176 
and documents 132 
and feedback 133 
and icon design 237 
and pop-up menus 82 
appearance of 134-138 
behavior of 139-173 
changing the size of 156-157 
closing 102, 152-154 
color design for 258 
color in 135-137 
controls in 134 
display order of on desktop 143--146 
help balloons for 324 
location of when opening 146-152 
moving 154-155 
opening 141-143 
parts of 134 
position of palettes in 97 
positions of 146-152 
scrolling 158-167 
size, changing 156-157 
sizes of, recommended 170 
splitting into panes 170-173 
standard and user states 168-170 
titles of 142-143 
types of 132 
utility 137-138 
zoom box effect 168-170 

word definitions 294 
word order and localization 19 
words in the interface 306-312 
Words Into Type 306 
words versus symbols 225 
word wrap 300 
workflow and modeless dialog boxes 178 
worldwide compatibility 16-24, 230 
worldwide software and accessibility 14 
wristwatch pointer 270 
WYSIWYG, as design principle 8 

z 
zoom boxes 134, 168-170 
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DMaking It Macintosh 
The Macintosh Human Interface Guidelines Companion 
by Apple Computer, Inc. 

The best way to learn about the Macintosh 
interface is to see it demonstrated live on the 
screen. Making It Macintosh is a CD-ROM that 
does just that. It contains over 100 animated 
examples of implementing the Macintosh 
desktop interface. You'll experience, 
interactively, both correct and incorrect uses of 
icons; controls such as buttons, checkboxes, 
and radio buttons; menus; dialog boxes; and 
windows. You'll also get suggestions for 
including help balloons in your program and 
for incorporating QuickTime movies. 

APDA part#: R0450LUA $39.95 

Ordering by phone: 
1-800-282-2732 U.S. 
1-800-637-0029 Canada 
716 871-6555 International 

Ordering by fax: 
716 871-6511 

Everyone on the project team can benefit from 
using Making It Macintosh. To run it, you'll 
need 

•a Macintosh with at least 5 MB of memory, a 
13 inch color monitor, and a CD-ROM drive 

• Macintosh System 7 or later 

• QuickTime (the QuickTime system extension 
is included on this disc for you to install if it's 
not already resident on your Macintosh). 

Ordering electronically: 
An APDA ordering folder can be 
found on the following online services: 

Applelink: APDA 
CompuServe: 76666,2405 
America Online: APDA 
Internet: APDA@apple.apple.com 
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> $29°95 USA 
> $38°95 CANADA 

by Apple Computer, Inc. 

lvlacintosb Human Interface Guidelines provides authoritative information on the theory behind the 
Macintosh "look and feel" and the practice of using individual interface components. This book includes many 
examples of good design and explains why one implementation is superior to another. Anyone designing or 
creating a product for Macintosh computers needs to understand the information in this book. 

Read this book to learn 

• how people interact with computers 
• the principles of the Macintosh human interface 
• interface behaviors, such as responses to user input from the mouse or keyboard 
• interface elements, such as menus, windows, dialog boxes, controls, and icons 
• the imponance of designing for worldwide markers and for people with disabilities 
• effective use of color 
• guidelines for using language clearly and consistently 
• suggestions for creating an effective design process, including how to manage complexity in software and 

how to extend the interface beyond these guidelines 
• sources of fmther information 

At the back of the book is a checklist for evaluating how well your program conforms to the human interface 
guidelines. 

To get the most out of this book, you should be familiar with acintosh computers. If you are a programmer, 
you should also consult Inside Macintosh: Macintosh Toolbox Essentials for complete information on the 
technical implementation of your program and its interface. 
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